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ABSTRAK
EMILIA FATMAWATI. Ekstrak Etanol Daun Salam dan Fraksinya
sebagai Inhibitor -Amilase. Dibimbing oleh ELLY
SURADIKUSUMAH dan IRMA HERAWATI SUPARTO.

Eugenia polyantha yang dikenal dengan nama salam adalah
tanaman obat yang banyak digunakan dalam mengobati
berbagai penyakit, termasuk diabetes. Tujuan penelitian ini
adalah memperoleh fraksi teraktif penghambat aktivitas
-amilase dari ekstrak etanol daun salam serta mengidentifikasi

kandungan fitokimianya. Ekstrak etanol kasar difraksinasi
menggunakan ekstraksi cair-cair memperoleh 3 fraksi, yaitu
fraksi n-heksana, fraksi etil asetat, dan fraksi air. Uji aktivitas
inhibisi -amilase menunjukkan bahwa semua fraksi aktif
menghambat -amilase, dengan fraksi air menunjukkan
aktivitas tertinggi sebesar 22.52%. Fraksinasi lanjutan fraksi air
menggunakan kromatografi kolom silika gel dengan elusi gradien
menghasilkan 4 fraksi. Semua fraksi menunjukkan aktivitas
hambat -amilase; fraksi 2 menunjukkan aktivitas tertinggi,
yaitu 57.57%. Berdasarkan uji fitokimia, komponen kimia yang
terkandung dalam fraksi teraktif adalah golongan alkaloid,
flavonoid, dan saponin.

Kata kunci: alkaloid, -amilase, flavonoid, salam, saponin

ABSTRACT

EMILIA FATMAWATI. Ethanolic Extract of Eugenia polyantha
Leaves and Its Fraction as -Amylase Inhibitor. Supervised by
ELLY SURADIKUSUMAH and IRMA HERAWATI SUPARTO.

Eugenia polyantha known as salam in Indonesia is widely
used as herbal medicinal plant to treat various diseases,
including diabetes. The objectives of this research are to obtain
the active fraction of ethanolic salam leaves extract, which is
inhibitory against -amylase activity, and to identify
phytochemical constituents of the fractions. Crude ethanolic
extract fractionated by liquid-liquid extraction gave 3 fractions,
namely n-hexane, ethyl acetate, and water fractions. All fractions
showed inhibitory activity against -amylase and water fraction
showed the highest activity with the inhibition of 22.52%.
Subsequent fractionation of the water fraction using silica gel
column chromatography with gradient elution produced 4
fractions. All fractions showed inhibitory activity against -
amylase; fraction 2 showed the highest activity with the
inhibition of 57.57%. Phytochemical screening showed that



alkaloids, flavonoids, and saponins were the chemical
constituents of the active fraction.

Keywords: alkaloids, -amylase, Eugenia polyantha, flavonoids,
saponins
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PENDAHULUAN

Bab pendahuluan memuat latar belakang atau alasan kuat
dilakukannya penelitian, tujuan, dan hipotesis jika ada. Di dalam
pendahuluan dijelaskan pula perumusan atau pendekatan
penyelesaian masalah dan alasan pemilihan metode yang
digunakan. Bergantung pada proses perumusan masalah
penelitian, bagian Kerangka Pikir dan Hipotesis dapat ditulis di
sini, tidak ditulis dalam bab tersendiri.

Paparan tidak berbelit-belit atau dimulai dengan latar
belakang yang terlalu umum. Pernyataan mengenai apa yang
diteliti dan apa yang diharapkannya diawali dengan pemikiran
logis. Tujuan penelitian ditulis di bagian akhir bab ini dengan
memilih kata kerja yang hasilnya dapat diukur dan dilihat, seperti:
menguraikan, menerangkan, membuktikan, menjajaki, menguji,
membuktikan, atau menerapkan suatu gejala, konsep atau
dugaan, atau bahkan membuat suatu prototipe. Jangan
menggunakan kata kerja mengetahui atau memahami.

Untuk tesis/disertasi dengan pola rangkaian penelitian,
dapat dituliskan telaah pustaka secara umum. Kebaruan (novelty)
merupakan hal penting yang harus jelas tersurat atau tersirat
dalam disertasi. Hal ini berarti penelitian disertasi bukan sekadar
mengulang atau mengadaptasi penelitian yang telah dikerjakan
oleh orang lain. Kebaruan dapat berupa penggunaan metode
baru atau pendekatan baru untuk menelaah suatu permasalahan.
Kebaruan dapat juga berupa perbaikan asumsi yang biasanya
diambil untuk penyederhanaan dalam menelaah suatu
permasalahan atau gejala, sehingga kebaruan yang ditawarkan
ini merupakan sumbangan bermakna dari penulis pada
pengembangan ipteks.

On the Insert tab, the galleries include items that are
designed to coordinate with the overall look of your document.
You can use these galleries to insert tables, headers, footers, lists,
cover pages, and other document building blocks. When you
create pictures, charts, or diagrams, they also coordinate with
your current document look.

You can easily change the formatting of selected text in the
document text by choosing a look for the selected text from the
Quick Styles gallery on the Home tab. You can also format text
directly by using the other controls on the Home tab. Most
controls offer a choice of using the look from the current theme
or using a format that you specify directly.

To change the overall look of your document, choose new
Theme elements on the Page Layout tab. To change the looks
available in the Quick Style gallery, use the Change Current
Quick Style Set command. Both the Themes gallery and the
Quick Styles gallery provide reset commands so that you can
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always restore the look of your document to the original
contained in your current template.

Latar Belakang

Latar Belakang memuat ulasan singkat mengapa penelitian
perlu dilakukan. Uraian dimulai dengan hal yang unik, fakta,
masalah, dan pendapat yang mendasari dilakukannya penelitian.
Di dalamnya diuraikan juga alasan teoretis dan alasan praktis
dari perlunya penelitian dilakukan, dan bagaimana masalah
tersebut dapat dipecahkan dan manfaat dari penyelesaian
masalah.

Perumusan Masalah

Berbekalkan latar belakang dan kerangka pikir, masalah
yang diteliti dapat dirumuskan. Masalah yang dirumuskan harus
jelas dan fokus pada kata kunci utama yang unik. Dalam
merumuskan masalah, deskripsi lokasi studi terutama
keunikannya sudah termasuk dalam dalam pertimbangan. Untuk
memperjelas perumusan masalah, dapat juga dibuat beberapa
pertanyaan yang hendak dijawab dalam penelitian itu. Dalam
uraian harus tercakup pendekatan yang digunakan dalam
perumusan masalah. Untuk membantu mengikuti alur pikir
secara skematis, dapat juga dibuat bagan alir kerangka proses
dan rumusan masalah serta pencapain tujuan penelitian.

Tujuan Penelitian

Pernyataan tujuan penelitian ialah pernyataan singkat dan
jelas tentang tujuan yang akan dicapai sebagai upaya
pemecahan masalah maupun memahami gejala (fenomena)
yang dijelaskan dalam latar belakang. Gunakan kata kerja yang
hasilnya dapat diukur. Bila ada atau memungkinkan, dapat ditulis
manfaat atau kegunaan hasil penelitian bagi kepentingan
pengembangan ipteks, pertimbangan dalam mengambil
kebijakan, kepentingan profesi maupun masyarakat pada
umumnya.



3

Manfaat Penelitian

On the Insert tab, the galleries include items that are
designed to coordinate with the overall look of your document.
You can use these galleries to insert tables, headers, footers, lists,
cover pages, and other document building blocks. When you
create pictures, charts, or diagrams, they also coordinate with
your current document look. You can easily change the
formatting of selected text in the document text by choosing a
look for the selected text from the Quick Styles gallery on the
Home tab. You can also format text directly by using the other
controls on the Home tab.

Gambar 1 Diameter bunga krisan cv. Red
Granada ( ) dan Gold van
Langen ( ) pada beberapa tingkat
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Ruang Lingkup Penelitian

On the Insert tab, the galleries include items that are
designed to coordinate with the overall look of your document.
You can use these galleries to insert tables, headers, footers, lists,
cover pages, and other document building blocks. When you
create pictures, charts, or diagrams, they also coordinate with
your current document look. You can easily change the
formatting of selected text in the document text by choosing a
look for the selected text from the Quick Styles gallery on the
Home tab. You can also format text directly by using the other
controls on the Home tab.

Tabel 1 Tingkat kekerasan dan kandungan gula buah pisang
ambon pada suhu simpan yang berbeda dan pemberian
putresina

Perlakuan
Kekerasan buah dan kandungan gula

pada hari ke-
0 7 14

Kekerasan buah (mm 50 g-1 detik-1)a
Suhu
simpan
15 ºC 10.20a 13.40a 11.83a
28 ºC 10.64a 14.22a 88.43b

Putresina
Dengan

putresina
11.07a 13.23a 21.19a

Tanpa
putresina

10.76a 14.40a 41.82b

Gula (%)a
Suhu
simpan
15 ºC 0.38a 0.56a 0.73a
28 ºC 0.55a 1.82a 14.41b

Putresina
Dengan

putresina
0.53a 0.87a 6.98a

Tanpa
putresina

0.40a 1.52a 6.91a
aAngka-angka pada kolom yang sama yang diikuti oleh huruf yang
sama tidak berbeda nyata pada taraf uji 5% (uji selang berganda
Duncan).
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TINJAUAN PUSTAKA (OPSIONAL)

Pustaka yang digunakan dalam bab ini ialah acuan primer,
diutamakan artikel jurnal dan paten yang relevan dengan bidang
yang diteliti, terkini, dan asli (state of the art). Diktat dan buku
ajar tidak termasuk acuan primer. Tinjauan pustaka memuat
telaah singkat, jelas, dan sistematis tentang kerangka teoretis,
kerangka pikir, temuan, postulat-postulat, prinsip, asumsi, dan
hasil-hasil penelitian yang relevan yang melandasi masalah
penelitian atau gagasan guna menggali pemahaman mengenai
masalah penelitian dan pemecahan masalahnya. Oleh karena itu,
dari tinjauan pustaka harus dapat diturunkan kerangka pikir,
hipotesis penelitian, dan metode penelitian.

METODE

Bab ini dapat diawali dengan kerangka pendekatan studi.
Metode penelitian dapat berupa percobaan laboratorium,
percobaan lapangan, dan survei lapangan yang dirancang sesuai
dengan tujuan atau jenis penelitian, seperti: eksploratif,
deskriptif, koreksional, kausal, komparatif, eksperimen, tindakan
(action research), pemodelan, analisis suatu teori, atau
kombinasi dari berbagai jenis penelitian tersebut. Untuk
penelitian yang menggunakan metode kualitatif, jelaskan
pendekatan yang digunakan, proses pengumpulan dan analisis
informasi, dan proses penafsiran hasil penelitian. Maksud dari
perincian ini ialah untuk menjamin keterulangan hasil.

Bahan

Untuk penelitian yang memerlukan bahan berupa organisme,
perlu diperinci asal tumbuhan, hewan, atau mikroorganisme
dengan identitas spesies atau galurnya. Bahan kimia yang lazim
terdapat di laboratorium tidak perlu diperinci. Pada penelitian
yang besifat eksperimen, nama pabrik pembuat reagen yang
digunakan ada kalanya perlu disebutkan. Sumber bahan dari
perusahaan atau individu maupun lembaga dapat dituliskan
sepanjang hal itu sangat spesifik. Penyebutan merek dagang
perlu dihindari sebab karya ilmiah bukan media iklan.
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Alat

Peralatan khusus perlu dideskripsikan secara lengkap. Merek
instrumen utama sering kali diperlukan untuk menunjukkan
kecanggihan atau ketelitian alat yang digunakan, misalnya
“senyawa organoklorin dianalisis dengan kromatograf gas-
spektrometer massa Hewlett Packard (HP) 6890/5973 yang
menggunakan kolom kapiler 50 m 0.22 mm 0.25 m HT-8
(SGE).” Peralatan umum yang lazim digunalan di lapangan atau
di laboratorium tidak perlu diperinci karena dengan sendirinya
akan terungkap saat prosedur kerja dipaparkan.

Prosedur Analisis Data

Analisis data menjelaskan cara menganalisis atau teknik
mengolah data yang digunakan untuk menarik simpulan dari
hasil kajian dari topik yang diteliti. Untuk disertasi dengan pola
rangkaian penelitian, Metode diuraikan secara terpisah-pisah
sesuai dengan subjudul penelitian.

HASIL DAN PEMBAHASAN

Hasil penelitian dapat digabung dengan pembahasan
menjadi bab Hasil dan Pembahasan. Pemisahan atau
penggabungan kedua bagian ini bergantung pada keadaan data
dan kedalaman pembahasannya sesuai dengan arahan

Tabel 2 Tingkat kekerasan buah pisang raja pada suhu
simpan yang berbeda dan pemberian putresina

Perlakuan
Kekerasan buah dan kandungan gula

pada hari ke-
0 7 14

Kekerasan buah (mm 50 g-1 detik -1)a
Suhu Simpan
15ºC 9.20a 13.40a 11.83a
28ºC 10.64a 11.22a 80.43b
Putresina
Dengan
putresina 12.07a 13.23a 11.19a
Tanpa
putresina 10.76a 14.41a 41.12b

aAngka-angka pada kolom yang sama yang diikuti oleh huruf yang sama
tidak berbeda nyata pada taraf uji 5% (uji selang berganda Duncan).



7

pembimbing. Bila Hasil dan Pembahasan disatukan dalam satu
bab, sajikan dahulu hasil penelitian, beri penjelasan yang cukup
untuk temuan penting, lanjutkan dengan analisis dan kemudian
dengan pembahasan. Subbab dalam Hasil dan Pembahasan
dikembangkan secara sistematis dan mengarah ke simpulan.

Hasil

Hasil penelitian dituliskan secara sistematis sesuai dengan
data yang diperoleh dan analisis yang dilakukan. Bab Hasil dapat
dibagi dalam beberapa subbab atau bahkan dalam beberapa bab
dengan judul yang berbeda-beda sesuai dengan tujuan penelitian.
Misal: dimulai dengan deskripsi daerah penelitian (setting) dan
diikuti oleh beberapa bab untuk menjawab setiap tujuan
penelitian. Hasil penelitian disajikan dengan jelas, terutama
ketika memaparkan temuan penting.

Pembahasan

Sebelum menentukan apa yang harus diuraikan dalam
Pembahasan, penulis hendaknya membaca lagi dengan saksama
tujuan penelitian dan hipotesis agar arah pembahasan
difokuskan untuk menjawab tujuan dan menguji hipotesis.
Pembahasan merupakan tempat penulis mengemukakan
pendapat dan argumentasi secara bebas, tetapi singkat dan logis
menuju tujuan penelitian yang ingin dicapai. Hindari alur uraian
yang berputar-putar. Kemampuan menganalisis penulis sebagai
seorang calon ilmuwan dipertaruhkan di bagian ini.

Panduan Teknis Penulisan

Dalam pembuatan karya tugas akhir, kendala teknis dalam
penggunaan aplikasi pengolah kata sering ditemui. Pada bagian
ini, beberapa langkah untuk menyelesaikan kendala tersebut
akan diberikan. Penyelesaikan kendala tersebut disesuaikan
dengan templat ini. Panduan teknis yang lebih lengkap dapat
diakses di situs http://ppki.ipb.ac.id.

Pengaturan Style Tulisan
Judul bab, subbab, dan subsubbab masing-masing memiliki

format penulisan tersendiri (lihat Lampiran 1 buku Pedoman
Penulisan Karya Ilmiah). Format tersebut dapat diatur secara
otomatis menggunakan fitur styles pada Microsoft Word. Pada
templat ini, beberapa style yang sering digunakan dalam
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penulisan karya ilmiah telah tersedia (Gambar 2). Style dapat
diakses pada menu Home.

Style yang disediakan oleh templat ialah style untuk daftar
ilustrasi (tabel, gambar, dan lampiran), daftar pustaka, tubuh
tulisan, judul bab, judul subbab, judul subsubbab, dan judul
ilustrasi. Beberapa style tersebut tetap memerlukan pengaturan
secara manual yang dilakukan oleh penulis karya ilmiah.
Contohnya, penomoran pada daftar tabel, gambar, dan lampiran
harus diulang pada setiap daftar ilustrasi. Oleh karena itu,
pengecekan format oleh penulis tetap disarankan untuk
dilakukan sebelum karya ilmiah dicetak.

Pengaturan Judul Bab, Subbab, dan Subsubbab
Untuk mengatur format judul bab, subbab, dan subsubab,

fitur Style dapat digunakan. Untuk memberikan Style pada ketiga
judul tersebut, sorotlah judul tersebut, kemudian pilih Style yang
sesuai dengan jenis judul yang diatur. Contohnya, teks yang
akan dijadikan judul bab disorot, kemudian Style judul bab dipilih.
Pengaturan Style pada judul-judul tersebut dapat mempermudah
proses pembuatan daftar isi pada karya ilmiah. Jarak antara judul
dan bagian di bawahnya telah diatur secara otomatis. Akan
tetapi, jarak antara judul dan bagian di atasnya tetap harus
diatur secara manual karena beberapa kendala teknis. Berikan
jarak yang sesuai dengan yang tercantum pada PPKI.

Gambar 2 Style yang tersedia pada templat
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Pembuatan Daftar Isi
Daftar isi dapat dibuat secara otomatis menggunakan

Microsoft Word. Syaratnya ialah setiap judul bab, subbab, dan
subsubbab telah diatur menggunakan style yang tersedia. Untuk
membuat Daftar Isi, letakkan kursor pada halaman Daftar Isi.
Kemudian, pilihlah References, Table of Contents, dan Insert
Table of Contents. Pada jendela yang muncul, pilih opsi seperti
yang tergambar pada Gambar 3. Kemudian, tekan tombol OK.
Apabila setelah Daftar Isi dibuat terdapat perubahan pada tulisan,
tekan tombol kanan tetikus pada daerah Daftar Isi, kemudian
pilih Update Field. Apabila yang berubah hanya halaman saja,
pilihlah opsi Update page number only. Apabila sistematika
tulisan juga berubah, pilihlah opsi Update entire table. Setelah itu,
tombol OK ditekan. Nomor halaman untuk Daftar Isi, Daftar
Gambar, Daftar Lampiran, Lampiran, dan Riwayat Hidup harus
disesuaikan secara manual karena beberapa kendala teknis.

Gambar 3 Opsi pembuatan bagian Daftar Isi

Gambar 4 Membuat text box
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Pengaturan Tata Letak Tabel dan Gambar
Kesulitan yang sering ditemui dalam penulisan karya ilmiah

ialah peletakan tabel dan gambar yang kurang tepat. Hal ini
menimbulkan ruang kosong yang cukup banyak pada bagian
bawah halaman atau terpotongnya tulisan dalam sebuah
halaman. Untuk mengatasi hal tersebut, gambar atau tabel dapat
diletakkan dalam sebuah text box yang diletakkan di bagian atas
atau bawah halaman.
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Pertama, buatlah sebuah text box. Pada Microsoft Word
2007 dan 2010, text box dapat dibuat pada menu Insert Text
Box (Gambar 4). Kemudian, pindahkan gambar atau tabel
beserta judulnya ke dalam text box tersebut, dan sesuaikan
ukuran text box tersebut Sesuaikan ukuran text box sesuai

Gambar 5 Jendela Layout

Gambar 6 Pilih Top and Bottom pada
jendela Text
Wrapping
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dengan besarnya gambar atau tabel. Lebar text box disarankan
sama dengan bidang gambar agar lebar judul tidak melebihi
bidang gambar atau tabel. Namun, jika lebar gambar kurang dari
10 cm, lebar text box diatur sebesar 10 cm. Hal ini dilakukan
agar bidang judul tidak terlalu sempit.

Selanjutnya, tata letak text box harus diatur agar sesuai
dengan format yang diberikan dalam Pedoman Penyajian Karya
Ilmiah. Opsi pengaturan tata letak berada pada jendela Layout.
Untuk masuk ke jendela tersebut pada Word 2007, klik kanan
pada text box kemudian pilih Format Text Box Layout
Advanced. Pada Word 2010, klik kanan pada text box kemudian
pilih More Layout Options.

Pada Position, atur nilai horizontal alignment dan vertical
alignment sesuai dengan Gambar 5. Pastikan pilihan Allow
overlap tidak dicentang. Setelah itu, pilih Wrapping Style, Top
and Bottom (Gambar 6). Setelah tombol OK ditekan, posisi text
box akan disesuaikan dengan opsi yang telah diatur sebelumnya.
Jangan lupa untuk menghilangkan warna garis text box yang
secara default bewarna hitam. Dengan menggunakan text box,
posisi gambar atau tabel dapat diatur dengan mudah tanpa
menimbulkan ruang kosong yang signifikan pada karya ilmiah.

Pemberian Judul Tabel, Gambar, dan Lampiran
Tabel, Gambar, dan Lampiran yang dicantumkan dalam

karya ilmiah harus diberi judul. Untuk mempermudah pembuatan
Daftar Tabel, Gambar, dan Lampiran, sebaiknya fitur caption
pada Word digunakan. Caption dapat diberikan dengan menekan
tombol kanan tetikus pada Gambar atau Tabel. Setelah itu,
muncul jendela caption (Gambar 7). Pilihlah label yang sesuai
dengan jenis ilustrasi. Judul ilustrasi dimasukkan pada text box
Caption. Aturlah format judul ilustrasi sesuai dengan yang

Gambar 7 Jendela untuk memasukkan judul
ilustrasi
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tercantum pada PPKI.

Pembangkitan Daftar Tabel, Gambar, dan Lampiran
Daftar Tabel, Gambar, dan Lampiran dicantumkan pada

tulisan. Ketiga daftar tersebut dapat dibuat dengan
menggunakan fitur Table of Figures. Namun, setiap judul Tabel,
Gambar, dan Lampiran harus diberi judul dengan menggunakan
caption agar fitur ini dapat digunakan.

Fitur ini dapat digunakan dengan memilih menu References
Insert Table of Figures. Setelah itu, jendela seperti pada

(Gambar 8) akan muncul. Pastikan semua kolom terisi sesuai
dengan Gambar 8. Bagian Caption label diisi dengan jenis
ilustrasi yang ingin dibuat daftarnya.

Setelah daftar dibuat, sorotlah seluruh bagian daftar
tersebut, kemudian berikan style Daftar Ilustrasi. Setiap baris
pada daftar akan diberi nomor secara otomatis. Apabila terjadi
ketidaksesuaian penomoran, pengaturan penomoran harus
diatur kembali. Contohnya, poin pertama Daftar Gambar diberi
nomor 3, padahal seharusnya diberi nomor 1. Apabila hal ini
terjadi, tekanlah tombol kanan tetikus pada nomor poin pertama,
kemudian pilih opsi Restart Numbering.

Pengaturan Persamaan Matematika
Seringkali, persamaan perlu dituliskan dalam karya tulis

ilmiah. Persamaan dapat dibuat dengan menggunakan fitur
equation editor. Persamaan yang disajikan dalam bentuk gambar
tidak disarankan karena kualitas pada saat pencetakan akan

Gambar 8 Jendela pembuatan Daftar
Gambar, Tabel, dan Lampiran
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menurun. Equation editor dapat dibuka dengan memilih menu
Insert, Equation, lalu pilih Insert New Equation.

Harus diperhatikan bahwa Word akan memberikan fon
Cambria Math pada setiap persamaan yang dibuat. Untuk
mengubah fon menjadi Times New Roman, persamaan harus
diubah terlebih dahulu dalam bentuk normal text. Pengubahan
dilakukan dengan menyorot persamaan, memilih menu Design,
kemudian mengaktifkan tombol normal text yang terdapat pada
sisi kiri. Setelah hal tersebut dilakukan, barulah jenis fon untuk
persamaan dapat diubah. Pastikan penulisan persamaan sesuai
dengan yang terdapat pada buku Pedoman Penulisan Karya
Ilmiah. Berikut merupakan contoh persamaan yang fonnya telah
diubah menjadi Times New Roman.

fx=a0+ n=1
∞ an cos

nπx
L +bn sin

nπx
L ; dengan x ≥ 0�

Penggunaan Page Break
Bab yang baru tidak harus ditulis pada halaman baru,

termasuk penulisan Daftar Pustaka. Jika bab baru ingin ditulis
pada halaman baru, page break disarankan untuk digunakan.
Pada beberapa kasus, penulis karya ilmiah memberikan
beberapa baris kosong pada halaman yang berada tepat di bab
baru tersebut. Hal tersebut tidak efisien karena apabila dilakukan
pengubahan pada bagian di atasnya, awal bab baru akan turun.
Untuk mempermudah, gunakan fitur page break. Page break
dapat dimasukkan dengan memilih menu page layout breaks

page breaks (Gambar 9). Dengan page breaks, posisi judul
bab pada awal halaman tidak akan mengalami perubahan
walaupun bagian sebelum halaman tersebut mengalami
perubahan.

SIMPULAN DAN SARAN

Simpulan

Simpulan merupakan jawaban dari tujuan yang sudah
ditentukan dan tidak dimaksudkan sebagai ringkasan hasil.
Dalam Simpulan, penulis harus dan hanya menjawab masalah
dan tujuan penelitian yang telah dirumuskan pada Pendahuluan.
Simpulan merupakan generalisasi dari hasil penelitian dan
argumentasi penulis, atau pernyataan singkat yang merupakan
hakikat dari bab Hasil dan Pembahasan atau hasil pengujian
berbagai hipotesis yang berkaitan.
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Simpulan merupakan hasil penelitian yang boleh jadi telah
dikemukakan dalam perumusan masalah dan telah diberi
jawaban sementara berupa hipotesis. Dalam menulis simpulan,
penulis harus membedakan dugaan, temuan, dan simpulan hasil
studi. Pernyataan simpulan harus dilakukan secara cermat dan
hati-hati. Penyampaian simpulan ini dapat dilakukan sebanyak 3
kali, yakni dalam Pembahasan, Simpulan, dan Abstrak sehingga
diperlukan kecermatan untuk menyajikannya dengan ungkapan
yang berbeda-beda.

Saran

Saran seyogianya mengarah ke implikasi atau tindakan
lanjutan yang harus dilakukan sehubungan dengan temuan atau
simpulan penulis. Saran yang dikemukakan harus berkaitan
dengan pelaksanaan atau hasil penelitian. Dengan demikian
saran ini mengemukakan hal-hal yang perlu diteliti lebih lanjut
terutama untuk memperbaiki kelemahan atau kekurangan dalam
penelitian yang dilakukan atau perbaikan asumsi yang diambil
sehingga didapatkan hasil yang lebih baik. Jadi, saran tersebut
harus diuraikan secara spesifik. Jangan menyarankan hal-hal
yang tidak dianalisis dan dibahas dalam penelitian serta terkesan
menggurui atau memuaskan keinginan peneliti. Untuk penelitian
yang berkaitan dengan permasalahan kebijakan, tidak perlu
menyarankan kebijakan yang tidak berkaitan dengan hasil
penelitian.

Gambar 9 Menu untuk memasukkan page break

Gambar 10 Contoh gambar yang
memiliki lebar
kurang dari 10 cm
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Lampiran 1 Rata-rata dan simpangan baku beberapa sifat físik
dan kimia tanah dari 78 contoh tanah di Kebun
Percobaan Ciheuleut

Sifat Rata-rata Simpangan baku
Pasir (%) 47.66 23.81
Lempung (%) 21.80 11.94
Liat (%) 30.72 18.09
C-organik (%) 0.61 0.57
Rapatan isi (mg m-3) 1.43 0.16
KTK (mek 100 g-1
tanah)a

18.08 17.09

KAT pada KL (g g-1) 23.62 10.80
KAT pada TLP (g g-1) 11.11 9.05
aBanyaknya 70 contoh tanah; KTK: kapasitas tukar kation, KAT: kadar
air tanah, KL: kapasitas lapang, TLP: titik layu permanen.
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Lampiran 2 Umur, indeks luas daun, dan hasil biji kering jagung
yang ditanam pada lima ketinggian tempat

Ketinggian
(m dpl)

Umur
(hari)

Indeks luas
daun

Hasil
(ton ha-1)

85
6

115 3.10 5.69

60
5

106 3.09 5.43

40
0

100 2.47 4.80

21
0

93 2.46 4.25

10
88 2.12 4.03
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RIWAYAT HIDUP

Dalam riwayat hidup dijelaskan tempat dan tanggal
kelahiran mahasiswa, putra dan putri ke berapa dari orang tua,
nama kedua orang tua atau wali. Untuk skripsi, tuliskan
pendidikan penulis seja\k sekolah menengah hingga terdaftar
sebagai mahasiswa IPB. Kegiatan penulis di luar akademik yang
menunjang pendidikan juga baik dicantumkan, terutama prestasi
akademik yang pernah diraih selama masa kemahasiswaan.
Uraian tentang riwayat hidup tidak lebih dari satu halaman.
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